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Computer	 :	 Computers is a comprehensive series of eight books designed specifically 
for the needs and requirements of the students studying in classes 1-8.  This 
series perfectly complies with the NCERT syllabus criteria and the National 
Curriculum Framework's vision. In keeping with NEP 2020’s guidelines, the 
series adopts an interactive approach to make it possible for the learners to 
enjoy computers.  This book includes enough questions in accordance with 
the NEP criteria. The fundamental principles of NEP which are recognizing, 
identifying and fostering the unique capabilities of each student, respect 
for diversity, and consideration for the local context in all topics, are always 
kept in mind while framing the book.

		  The topics are introduced in a way that children experience and learn 
through exploration.

		  Child-friendly language and contextual images have been incorporated 
throughout the series to make the material more understandable for young 
readers. This allows them to connect what they read and relate it  to the 
views, ideas, and experiences they encounter every day. 

Salient Features of the series:

Learning Outcomes	 :	 It guides both the teacher and the students towards the correct direction 
of efficient learning. It establishes the path of learning for efficient and 
superior learning results.

Warm Up	 :	 Children can connect their prior knowledge to the chapter's topic through 
simple yet engaging activities.

Teacher’s note 	 :	 An outline of guidelines for teachers to follow in the classroom in order to 
make lessons interactive and discussion-based.

Let me answer	 :	 Questions related to the topic which are  essential for checking pupil 
understanding and keeping them engaged with the task at hand.

Do You know	 :	 An interesting piece of information related to the topic.

Remember It 	 :	 Additional information about the topic to encourage children to wonder 
about various surroundings.

Kids’ IQ 	 :	 These questions have been included to reinforce learners to think,analyse 
and apply.

Up skill your 

Intelligence	 : 	 Ample exercises with a range of questions to support learning.

Critical Thinking	 :	 Questions which allow the learners to think clearly and rationally. 

Team Work 	 :	 It enables the students to collaborate with others.

		  The content is structured and well graded. Sincere efforts have been made 
to prevent any inconsistencies and make this series a perfect complement 
to the students' education. Any worthwhile recommendations for the 
improvement of the series are always welcome and greatly appreciated.

								          	   Author

Preface



             

             

             

FOCUS areas   of NEP 2020
It shows the right path of learning 
to the teacher as well as students. It 
establishes the direction of learning 
for efficient and superior learning 
results.

Children can connect their prior 
knowledge to the chapter's topic 
through simple yet engaging 
activities.

An outline of guidelines 
for teachers to follow in 
the classroom in order to 
make lessons interactive 
and discussion-based.

Additional information about the 
topic to encourage children to wonder 
about various surroundings.

It aids in providing a brief summary 
of the entire chapter.

Learning Outcomes Warm-Up

Teacher’s Note:

Remember It

Let's Recall

These questions have been included 
to reinforce learners to think,analyse 
and apply.

Kids' IQ



             

             

             

FOCUS areas   of NEP 2020
An interesting piece of information 
related to the topic. Questions which allow the learners 

to think clearly and rationally.

Questions related to the 
topic which are  essential for 
checking pupil understanding 
and keeping them engaged 
with the task at hand.

Do You Know
Critical Thinking

It enables the students to collaborate 
with others.

Team Work

Let me Answer

Ample exercises with a range of questions to 
support learning.

Upskill Your Intelligence
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Generations of computers1

Teacher’s 
Note:

Apprise students that with every passing generation, progress takes place that makes our 
life better and easier. 

At the end of this chapter, the students will be able to:
)) Know the characteristic features of different generations of computers.
)) Learn about the Primary and Secondary memory of a computer.

Learning Outcomes

Warm-up
Match the following. 
Four generations                  			   What did or do they use?

Grand Parents( Very old)	
				  

Parents ( Old)
						    

Adults ( Mid age)
	    				     

Baby ( 5-6 yrs)						    
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In today’s world, for almost every activity whether personal or business-
related; in one or other way, we rely on the computer system. It’s amazing 
how easily computers operate, in terms of speed, accuracy, and readiness. 
As a result of their high-speed processors and data storage devices, modern 
computers are more potent than earlier models which were only meant to be 
used for calculations. Since ancient times, simple manual machines like the 
Abacus helped people in doing calculations. 

In 1833, Charles Babbage who is referred to as the ‘Father of Computer’; 
invented the machine called Analytical Engine. It was the first-ever working 
model of a mechanical computer, whose structure is considered the basic 
framework of modern-day computers today - input, output and storage. 

 Generations of Computers

The technology employed changes with each generation. The modern-day 
computer is the result of changes that took place over a period of time. There 
are five generations of computers. 

First Generation of Computers (1940 - 1956)
The features of the first generation computers were:
�� These computers were huge in size.

“Hey Friends! Let’s learn about 
different generations of computers.

Generation of Computers

First Generation Second Generation Third Generation Fourth Generation Fifth Generation

Figure 1.1: Timeline
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�� The calculations were carried out 
using circuitry made of vacuum 
tubes.

�� They used a lot of electricity and 
produced a lot of heat.

�� They used punched cards for the 
communication of data. 

Examples: Mark I, ENIAC and UNIVAC.

Second Generation of Computers (1956 - 1963)
In this generation, assembly language and 
high-level programming languages like 
FORTRAN, and COBOL were used. The 
computers used batch processing and a 
multiprogramming operating system. 
Storage media such as tape, disk and 
printers were in use for output. 
The features of the second generation computers 
were:
�� They were a bit large but smaller, cheaper and 

faster than the first generation computers.
�� In order to perform the calculations, they 

used transistors instead of vacuum tubes.	
�� Magnetic tapes were used to store 

data.
�� In this generation, the use of the 

keyboard as an input device was 
also introduced. 

Examples: IBM 1620, IBM 7094 
AND UNIVAC 1108

Figure 1.2: First Generation Computers

Figure 1.4: Second Generation of Computer

Figure 1.3: Transistor

Do You Know?
Similar to modern-day electric bulbs, 
vacuum tubes existed. They used to fuse 
regularly and produced a lot of heat. 

The UNIVAC had 5200 vacuum tubes.
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Third Generation of Computers ( 1964 - 1971 ) 
Integrated circuits were developed in the third 
generation, which resulted in smaller-sized computers 
with better performance and more storage.
The main features of the third-generation computers 
were:
�� They used Integrated Circuits, which 

reduced the size and increased the speed 
of the computers.	

�� They were more affordable and efficient 
than second-generation computers. 

�� Monitors and keyboards were used for 
communication. 

Examples: Honeywell 6000 series, IBM system 
360 and UNIVAC 9000 series

Fourth Generation of Computers ( 1972 - 1981 )

The invention of Very Large 
Scale Integration (VLSI) 
came into existence in which 

thousands of transistors were on a single chip called 
a microprocessor.

The main features of the fourth-generation 
computers were:
�� The size of the computers was reduced to 

what we call a Personal computer. 
�� The speed of the computers was increased 

and the cost was reduced. 
�� GUI operating system was introduced. 

Examples: DEC 10, CRAY 2 and Apple II. 

Figure 1.5: Integrated 
circuit chips

Figure 1.6: Third 
Generation of Computer

Figure 1.7: VLSIC

Let Me Answer
Who comes in the fourth 
generation in your family?

Figure 1.8: Fourth 
Generation of Computer
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Fifth Generation of Computers ( 1982 - Present)

In the fifth generation, VLSI technology 
became ULSI (Ultra Large Scale Integration) 
technology. The devices are equipped with 
AI-based technologies like face detectors, 
fingerprint detectors and much more. 

The main features of the fifth-generation computers were:
�� The size, cost, speed and are improved with high performance.
�� Development of new versions of GUI Operating systems. 
�� The computers can recognise a human face, fingerprints and voice.

Examples: Notebooks from IBM and Robots. 

The two key factors that have accelerated the development of different 
generations are processing speed and storage capacity. It is important for us 
to know about Computer memory and its types.

 Computer Memory and Its Types

Computer memory refers to the storage area of a computer where all the 
data and instructions are stored.

Primary (Internal) Memory Secondary (External) Memory

RAM

SRAM DRAM PROM EPROM EEPROM

ROM Hard Disk Blu Ray Disk CD/DVD Flash Drive

Computer Memory

Figure 1.9: Computer Memory

The first Microprocessor 
was created by Intel. 

Remember it!
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PRIMARY MEMORY

Primary Memory is a section of computer memory that the CPU can access 
directly, also called Main memory or Internal memory.  It has constrained 
capacity. We can broadly classify Primary Memory into two parts:

1. Read Only Memory or ROM

2. Random Access Memory or RAM

Read-Only Memory or ROM 

As the name suggests, we can only read from this 
memory and cannot write on it. It is the built-in 
memory of a computer. Moreover, it does not lose 
data after the power supply is cut off i.e. it is non-
volatile. Furthermore, its main function is to store 
the program and instructions permanently.

ROM is of three types:
�� PROM: 	 The user can only change the programmable Read-Only 

Memory once.
�� EPROM: 	 It is Erasable Programmable Read-Only Memory which 

can be erased as well as reprogrammed.
�� EEPROM: 	The Electrically Erasable Programmable Read-Only 

Memory can be modified by erasing the content and 
reprogrammed. 

Random Access Memory or RAM

Random-Access Memory 
is a type of computer 
memory that can be read 
and modified in any order. 
It is usually used to store 
working data and machine 

Figure 1.10: ROM

Figure 1.11: RAM
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code. The storage of data and instructions is temporary. It is a volatile memory, 
i.e. When the power is cut off, it loses its content.

We can broadly classify RAM into two types on the basis of behaviour:

�� SRAM: 	 As long as the computer is powered on, the data is kept in 
static RAM (SRAM).

�� DRAM: 	 This memory is temporary and constantly refreshes its 
content.

 Secondary Memory

Secondary Memory stores a large amount of information permanently, i.e., 
it doesn’t lose its memory when the power is off. It is also called External 
Memory.  Some of the secondary storage devices are Hard Disk, CD-ROM, 
Digital Versatile Disc, Blu Ray Disc and Pen Drive.

Hard Disk:

Hard disks are storage devices designed to hold a 
lot of information. It is the main and the largest 
secondary data storage device in a computer. Hard 
disk stores the operating system, software and other 
files. It is created using the collection of discs known 
as platters. The platters are placed one below the 
other. They are coated with magnetic material.

CD-ROM ( Compact Disc-Read Only Memory)

It is an optical storage device that has the capacity to 
hold a wide range of data in the form of text, photos, 
video, and audio. The storage capacity of a CD is up to 
700 MB of data. Its shape is circular and is made up of 
polycarbonate plastic. 

Figure 1.12: Hard Disk

Figure 1.13: CD-ROM
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DVD ( Digital Versatile Disc)

A Digital Versatile Disc, usually known as a DVD, 
resembles a CD in appearance but has a larger storage 
capacity, holding up to 4.7 GB of data. 

Blu-Ray Disc

A Blu-Ray Disc looks just like a CD or a DVD but it can 
store data or information up to 25 GB. It is developed for 
recording, rewriting and playing high-definition video.  
The name Blu-Ray is derived from the technology that 
is used to read the disc ‘Blu’ from the blue-violet laser 
and ‘Ray’ from an optical ray.

Pen Drive

A pen drive is a small device, which is used to transfer 
and store data. It is also called a USB drive or Flash 
drive. It comes in various storage capacities, such as 1 
GB, 2 GB, 4 GB, 8 GB, 16 GB, 32 GB, 64 GB, up to 1 
TB.

Kids’ IQ
List the names of the brands which make pen drives.

Let’s Recall
•	 Charles Babbage is referred to as the ‘Father of Computer’.
•	 There are five generations of computers. 
•	 First Generation Computers used punched cards for the communication of data. 
•	 In the second generation, the use of the keyboard as an input device was also introduced. 
•	 In the Fourth generation, GUI operating system was introduced.
•	 Primary Memory is also referred to as Main Memory.
•	 Secondary Memory is also referred to as External  Memory.

Figure 1.14: DVD

Figure 1.15: Blu-Ray Disc

Figure 1.16: Pen Drive

Let me Answer
For what purpose have you used a pen drive?
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Upskill Your Intelligence

A.	 Fill in the blanks

	 1.	 In ancient times, simple manual machines like .................... helped people in 
doing calculations.

	 2.	 .................... is referred to as the Father of Computer.

	 3.	 .................... was the first-ever working model of a mechanical computer.

	 4.	 There are .................... generations of computers. 

	 5.	 .................... circuits were developed in the third generation.

B.	 Write ‘T’ for True statements and ‘F’ for False statements.
	 1.	 Computers of the first generation were small in size.	
	 2.	 Magnetic tapes were used in the second-generation 
		  computers to store data.	
	 3.	 IBM system 360 is an example of a third-generation computer.	  
	 4.	 In the fifth generation of computers, VLSI came into existence.	
	 5.	 ULSI stands for Uniform Large Scale Integration.	

C. 	 Answer in one word.
	 1.	 A type of computer memory that can be read and modified in any order. 

...............................
	 2.	 A secondary storage device which resembles a CD in appearance but has a 

larger storage capacity. .................................
	 3.	 A storage device that is also referred to as a USB drive or Flash drive. .
		  ................................
	 4.	 The memory which is temporary and constantly refreshes its content. 
		  .................................
	 5.	 A storage device made up of Polycarbonate plastics. .................................
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D. 	 Write the following in expanded form. 
	 1.	 ROM - 		  ....................................................................................
	 2.	 RAM-		  ....................................................................................
	 3.	 CD-ROM-	 ....................................................................................
	 4.	 DVD-		  ....................................................................................
	 5.	 VLSI-		  ....................................................................................
E.	 Answer the following questions.
	 1.	 How many generations of computers are there?
		  ...................................................................................................................................
		  ...................................................................................................................................
	 2.	 Write the features of the second generation computers.
		  ...................................................................................................................................
		  ...................................................................................................................................
	 3.	 State the difference between the third generation and fourth generation 

computers.
		  ...................................................................................................................................
		  ...................................................................................................................................
	 4.	 What do you mean by Primary Memory? Explain.
		  ...................................................................................................................................
		  ...................................................................................................................................
	 5.	 Explain any three types of secondary storage devices.
		  ...................................................................................................................................
		  ...................................................................................................................................

Critical Thinking

A.	 Some features have been listed below. Segregate them in the appropriate 
columns.

ˡˡ GUI operating system was introduced.
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ˡˡ Punched Cards for the communication of data.

ˡˡ Usage of Integrated Circuits.

ˡˡ The computers can recognise human face, voice and finger prints.

ˡˡ The use of the keyboard as an input device was introduced.

First
Generation

Second
Generation

Third
Generation

Fourth
Generation

Fifth
Generation

B.	 Samaksh attended the marriage ceremony of his cousin. He wants to take all 
the pictures but the file is larger than 16GB. Advise him as to what should he 
do.

Team Work
	 Let us discuss the topic - Generation of Computers. 

	 Which generation of computer do 
you use? List 5 features.

1.	 ............................................................
2.	 ............................................................
3.	 ............................................................
4.	 ............................................................
5.	 ............................................................

	 Which types of secondery storage do 
you use? List the name of the devices.

1.	 ............................................................
2.	 ............................................................
3.	 ............................................................
4.	 ............................................................
5.	 ............................................................
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Learning More About 
Windows 10

2

At the end of this chapter, the students will be able to:
)) Know various features of Windows 10.
)) Enhance their knowledge of various components of Windows.
)) Change windows appearance.

Learning Outcomes

Warm-up
Number the following windows from older versions to advanced editions.

Teacher’s 
Note:

Assist students in arranging the editions of the windows in chronological order. Apprise 
them that continuous research and increased technology usage has led to the advanced 
editions of Windows by Microsoft.

Windows 7

Windows 2003

Windows 10

Windows VISTA

Windows XP

Windows NT
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“Hi Friends! Hi Friends! In the 
previous class, we already learnt 
about some of the features of 
windows 10. Let’s learn more!

As we know, a computer is a machine that cannot think on its own and 
requires instructions from us. The most important program of a computer 
is its operating System. Windows is such an operating system that acts as 
a medium through which we can interact with the hardware, using the 
software. 
The first GUI edition of windows with a new user interface was introduced 
in 1995 and was called Windows 95. 
Windows 10 is the latest version of Windows available in the market.

 Features of Windows 10
Following are the features of Windows 10
�� It is interesting and easy to use.
�� The most secured version of windows.
�� The use of graphics makes it quite interactive.
�� The enhanced tool, Cortana, allows in searching the information on the 

system or the web directly.
�� The new start menu helps to 

give us easy access to apps and 
services. 

�� The new Task view button on 
the taskbar provides the ability 
to open multiple desktops at the 
same time. You can create an 
unlimited number of desktops. 

Do You Know?
Bill Gates is the founder of Microsoft.

Figure 2.1: Window 10
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�� The window snapping feature allows working with multiple applications 
on the screen.

�� Microsoft Edge is the default browser of windows 10. It helps you to 
write and highlight directly on web pages.

�� With Windows Hello, you can instantly access your Windows 10 devices 
using a PIN, facial recognition software, or a fingerprint in a more private 
and secure way.

�� The window store provides a lot of free and paid applications. 

 Components of Windows 10

Components of Windows 10 

Desktop
The first screen that appears when 
we start the computer is called the 
Desktop. It has various icons of files 
and folders. By default, the taskbar 
is located at the bottom of the 
desktop screen. 

Icons
Icons are tiny images on the desktop that represent files, folders, and apps. 
Some of the common desktop icons include This PC, application icons, 
shortcut icons, and recycle bin. 

 Let us learn about these icons in detail

1.	 This PC Icon:	
	 It shows all the files and folders stored on our computer 

system. It helps us in ordering the data stored on the local 
drives efficiently. 

Figure 2.2: Desktop

Figure 2.3: 
This PC icon

Let Me Answer
What all files do you have 
on your desktop?
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2.	 Application Icons:	
	 To display a specific application on a 

computer, windows employ application 
icons. It provides easy access to the 
related application.

3.	 Shortcut Icons:	
	 A shortcut icon 

provides direct 
access to a certain 
application. It has a small arrow on its lower left.

4.	 Recycle Bin Icon:
All the deleted files/folders are moved into the 
Recycle bin. We can easily restore a file or a folder 
from recycle bin or it can be deleted permanently.

Start Button
It is at the bottom left of the screen. 
By clicking on it, we get two panels 
side by side. The panel on the left 
displays apps in a listed form in 
alphabetical order. Live titles which 
show the new updates are on the 
right panel. 

Taskbar
The long horizontal bar found at the desktop’s bottom is the taskbar.

Figure 2.8:  Windows Taskbar

Start button Open and pinned programmes Time and date

Cortana, Run and Search Notification Area

Figure 2.4: Application Icons

Figure 2.5:  Shortcut Icon

Figure 2.6:  Recycle bin

Figure 2.7:  Recycle bin

Let Me Answer
What do you mean by shortcut? 
Have you ever taken a shortcut?
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It shows the Start button on the extreme left side. Just next to the Start 
button is the search box, Cortana. It helps to browse both your computer 
and the web. To the right of the Cortana is the Task view button which 
allows accessing multiple desktops simultaneously. The area which lies 
in the mid of the taskbar contains the apps which are opened and are 
used frequently. In the taskbar, we have a notification area on the right 
side, which shows the clock, date, and some more icons. On the extreme 
right, the Peek button is present which makes the desktop visible by 
minimizing all the open windows. 

 Customising Window Appearance
With the wide range of settings in Windows 10, we can change the appearance 
to make the desktop and apps look better. 

Changing the wallpaper 
Follow the given steps to change the wallpaper.

Steps:
1.		  Right-click on the blank area of the desktop.
2.		  From the pop-up menu, select the Personalize option. 
3.		  The settings window will be displayed.
4.		  Under the Personalization panel, click on the background option.
5.		  Select the 

background 
available or click 
on the browse 
button to select 
the picture of 
your choice. 

6.		  The selected 
picture will be 
set as the desktop 
background. Figure 2.9: Background
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Setting the Screen Saver
A screensaver is a computer program that displays the black screen or fills 
it with moving patterns when the computer has been idle for a designated 
time.
Follow the given steps to change the screen 
saver.

Steps:
1.		  Right-click on the blank area of the desktop.
2.		  From the pop-up menu, select the Personalize option. 
3.		  The settings window will be displayed.
4.		  Select the Lock screen option from the left pane.
5.		  Click on the screen saver 

option, and a dialogue 
box will appear.

6.		  Select the desired Screen 
saver and click on the 
apply option.

7.		  The chosen screen saver 
will be applied. 

Live Tiles
In the right panel of the Start Menu, the 
most popular Universal apps in the form 
of resizable live tiles are displayed. All the 
latest information such as news, weather 
report and much more are shown here. 
Follow the given steps to resize a live tile.
Steps:
1.		  Click on the Start menu.
2.		  Right-click on the tile whose size you want to change.

Press window Key + L together to 
lock your computer.

Remember it!

Figure 2.10: Lock Screen

Figure 2.11: Live Tiles
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3.		  Select the option Resize, and choose the size of your choice from the 
sub-menu.

Turning a Live Tile On/Off 
Follow the given steps to turn on Live tiles.

Steps:
1.	 Click on the Start 

menu.
2.	 Right-click on the tile 

you want to turn on. 
3.	 Click on more, and 

click Turn live tile on.
Similarly, you can turn off 
the Live title by selecting 
Turn Live title off. 

Displaying Windows Together

Multiple application windows can be displayed side by side, in Windows 10. 

Follow the given steps to display windows together.

Steps:
1.	 Open Excel window, Word 

window and Paint 3D.
2.	 Now, Right-click on the 

blank area of the taskbar.
3.	 Select the ‘Show Windows 

Side by Side’ option from 
the pop-up menu.

4.	 All the three windows will 
be displayed side by side. 

Figure 2.12: Turning a Live Tile On/Off

Figure 2.13: Displaying Multiple Windows Together
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 File Explorer Window
Files and Folders stored in our system are displayed in the File Explorer 
Window. It allows us to view and manage files and folders. Further, we can 
create, open, move or delete a folder in this window. 

Opening File Explorer
Follow the given steps to open the File Explorer window.

Steps:
1.	 Click on the Start button.
2.	 Click on the File Explorer option.
3.	 The File Explorer Window will open.
4.	 Alternatively, click the Windows button (Windows button) + E.

Components of File Explorer Window

1.	 Search Box: In this 
box, we can search 
files or folders in the 
system. 

2.	 Navigation Pane: It 
is on the left and is 
used to explore disks 
and drives.

3.	 Content Area: It contains icons representing the drives in the system.
4.	 Address Bar: Here, the path of the currently open file or the folder is 

displayed. 

 Universal Apps of Windows 10
Universal App is an application that works on all devices from phones to 
high-powered desktops. Moreover, these apps can work on different types of 
devices such as iPhones and Smartwatches. 

Figure 2.15: File Explorer
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Some of the most useful apps are:

�� Weather App -  This app lets you know all 
about the Weather such as real-time rain 
alerts, minimum/maximum temperature and 
much more.

�� E-mail App - This app aids you to manage all 
your mail accounts in one place. Also, it gives 
the notification of all the incoming mails. 

�� News App - This application displays the 
latest news to keep the user up-to-date.

Kids’ IQ
Pragya is a content writer . She has to keep herself updated with the news every hour. 
Suggest the kind of app she should use for the same.

Let’s Recall
•	 The most important program of a computer is its operating System. 
•	 The first screen that appears when we start the computer is called the Desktop.
•	 All the deleted files/folders are moved into the Recycle bin.
•	 The long horizontal bar found at the desktop’s bottom is the taskbar.
•	 Files and Folders stored in our system are displayed in the File Explorer Window.
•	 Universal App is an application that works on all devices from phones to high-

powered desktops.

Figure 2.16: Weather App
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Upskill Your Intelligence

A.	 Fill in the blanks.

	 1.	 The most important program of a computer is its .....................

	 2.	 The first GUI edition of Windows with a new user was introduced in 
.....................

	 3.	 .................... is the latest version of windows available in the market.

	 4.	 The Window store provides a lot of free or paid .....................

	 5.	 The first screen that appears when we start the computer is called the ................

B.	 Answer in one word.

	 1.	 Tiny images on the desktop that represent files, folders and apps. 

		  .............................................................................................................................

	 2.	 Location of the taskbar.

		  .............................................................................................................................

	 3.	 An icon that provides direct access to a certain application.

		  .............................................................................................................................

	 4.	 The tiles which display the most popular Universal apps.

		  .............................................................................................................................

	 5.	 The window which displays files and folders stored in our system.

		  .............................................................................................................................

C.	 Write ‘T’ for True statements and ‘F’ for False statements.

	 1.	 A computer is a machine that thinks on its own.	

	 2.	 The first GUI edition of Windows was called  
Windows 95.	

	 3.	 Bill Gates is the founder of Microsoft.	
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	 4.	 In windows 10, we can create an unlimited number of desktops.	

	 5.	 All deleted files/folders are moved into This PC.	

D.	 Identify the following icons/apps and write their names.

	 ...................................	          ...................................		    ...................................

	 ...................................	          ...................................		    ...................................

E.	 Answer the following questions.

	 1.	 Write any five features of Windows 10.

		  .....................................................................................................................................

		  .....................................................................................................................................

	 2.	 Brief about any two components of Windows 10.

		  .....................................................................................................................................

		  .....................................................................................................................................

	 3.	 Write the steps to change the wallpaper.

		  .....................................................................................................................................

		  .....................................................................................................................................



29 Computer -5

	 4.	 What do you mean by a screen saver?

		  .....................................................................................................................................

		  .....................................................................................................................................

	 5.	 What is the purpose of the File Explorer Window?

		  .....................................................................................................................................

		  .....................................................................................................................................

Critical Thinking

A.	 Anushka wants to write the information from two different files. Suggest to 
her the option she can use to open two files side by side.

	 ....................................................................................................................................
	 ............................................................................................................................................

B.	 Unscramble the letters to form a word.

	 1.	 SLUIVNEAR PAP -	.......................................................................

	 2.	 VILE EILT -		  .......................................................................

	 3.	 DTESKPO -		  .......................................................................

	 4.	 SKBTAAR -		  .......................................................................

	 5.	 SNIOC-			  .......................................................................

Team Work

A.	 Work in pairs. Find out a quote on hard work by some famous personality and 
set it as your wallpaper.

B.	 Discuss with your friends.
	 1.	 Which type of wall paper do you like most?
		  a. nature			  b. famous persnalities		  c. 3D objects.
	 2.	 How did you the write the quote?
	 3.	 Discuss about your screen wallpaper.
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Advance Features of MS Word
3

At the end of this chapter, the students will be able to:
)) Apply the styling features in MS Word.
)) Insert symbols and shapes.
)) Set the page margins, size, orientation and colors.
)) Use Thesaurus to improve vocabulary.

Learning Outcomes

Warm-up

Can you make a friendship card?

Ask your parents to allow you to use their computer and make a friendship card 
to celebrate Friendship-Day with your friends.

Teacher’s 
Note:

With the help of the above activity, introduce the students to the advance features of MS-
Word 2016.
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Microsoft Word 2016 is the most popular word processor developed by 
Microsoft Corporation. It is one of the world’s largest companies in software 
development. 
Word 2016 has the ability to create, read, edit and share files at once very 
easily. Formatting can also be done in the documents. 
Let’s further study the advanced features of MS Word 2016.

 MS Word Styles
Styling is the process of altering the font’s appearance in terms of size, color, 
and themes. In MS Word, we can change the style of any text in a sentence 
or paragraph.
We can use the styles option, which include 
predetermined styles, to quickly change the 
font style.
Styling features can be applied to the following elements:

Paragraph

The outlook of a paragraph can be changed completely by changing its 
styling. A paragraph consists of different options like heading, quote, index, 
header, footer, bibliography, salutation, address and much more.

Character

The smallest element in a word document is a character.

“Hi friends! Let’s learn about 
the advanced features of MS-
Word, It helps up to learn 
various styling features.

Do You Know?
Using the design a style option provided 
in the styles drop-down list, you can 
build your own special styles.
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Linked Content
Linked Content is a mix of paragraphs and characters. It has styles available 
for both paragraphs and characters. 

Table
There are different table styles available such as Plane Table, Grid Table, List 
Table, Colourful Grid and many more.

List
A list contains ordered and unordered list items.
Follow the given steps to apply styles to a Paragraph.

Steps:
1.	 Select the desired paragraph.
2.	 In the style group, click on 

the more option.
3.	 A drop-down containing 

different style options will 
appear.

4.	 Place the cursor over the 
desired Style.

5.	 See the change in the selected text.

  Subscript

You must have observed TH after 
some numbers or some numbers 
like ‘2’ after some letters in chemical 
formulas. Denoting a number or 
letter above or below the baseline 
makes it either a Superscript or a 
Subscript. 

Let Me Answer
Tell the chemical formula which 
has a number as subscript.

Let Me Answer
What is a paragraph?

Figure 3.1: Applying Styles

Figure 3.2: Creating Subscript
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The subscript option places the selected text slightly below the baselines and 
makes it appear smaller than the rest of the text. 

Follow the given steps to create a Subscript.

Steps:
1.	 Type the formula CO2 and select 2.
2.	 From the font group, select the subscript Option.
3.	 You will notice that ‘2’ will be placed below the baseline.

  Superscript

The superscript option places the selected text slightly above the baselines 
and makes it appear smaller than 
the rest of the text. 

Follow the given steps to create a 
Superscript.

Steps:
1.	 Type the date 10th April and 

select th.
2.	 From the font group, select the 

superscript Option.
3.	 You will notice that ‘th’ will be 

placed above the baseline. 

  Inserting Symbols

Symbols are special characters. 

Follow the given steps to insert symbols.

Steps:
1.	 Take the cursor to the point where you wish to insert the symbol.

By pressing Ctrl+Shift++ key combination, 
you can create Superscript.

Remember it!

Figure 3.3: Creating Superscript
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2.	 Go to the Symbols group in the 
Insert tab, and select the symbol 
button. 

3.	 Pick a symbol of your choice or 
choose the more symbols option.

4.	 When you find the symbol of your 
choice, double-click on it.

5.	 The symbol will be inserted at the 
desired place.

6.	 Click on the cancel button.

  Undo and Redo Commands

MS Word 2016 keeps the record of all the alterations that we do in a document. 
The Undo command allows you to discard the most recent change. The Redo 
command reverses the most recent change made using Undo. These buttons 
appear in the Quick Acess Toolbar in Microsoft by default.

Follow the given steps to undo the last action.

Steps:
1.	 On the Quick Access Toolbar, click Undo. Alternatively, you can press 

Ctrl + Z. 
2.	 Click the drop-down arrow next to Undo, if you want to undo several 

actions at the same time. 

Figure 3.4: Symbol

Figure 3.5: Quick Access Toolbar

Quick Access 
Toolbar Undo Button Redo Button
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Follow the given steps to redo the last action.

Steps:
1.	 On the Quick Access Toolbar, click Redo. Alternatively, you can press 

Ctrl + Y.

  Page Settings

In Word, we have options for formatting 
the page and also for setting the page 
properties.

Setting Margins

A margin is the amount of space between the text and the edge of the page. 
The default margins are set at 1’’ from top and bottom and 1’’ from the left 
and right edge of the page. 

In Word 2016, we can manually set the margin on all four sides of a document.

Follow the given steps to set the Page Margins.

Steps:

1.	 Click on the Layout tab.

2.	 In the Page Setup group, select the 
Margins buttons.

3.	 Select the margin from the list or 
customise it as per your requirement. 

4.	 Type the values for Top, bottom, left 
and right margins.

5.	 In the Apply to drop-down list, choose 
the option : Whole document.

6.	 Click OK. 

Figure 3.6: Page Margins

Figure 3.7: Page Setup
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Setting Paper Orientation

The property to set the 
printing direction of the text 
is called Page Orientation. 
It is of two types: Portrait 
and Landscape Orientation. 
The default orientation is 
Portrait, which is vertical.

Follow the given steps to 
change paper orientation to Landscape (Horizontal).

Steps:
1.	 Select the Layout tab.
2.	 In the Page Setup group, click on the Orientation button.
3.	 From the drop-down list, choose the landscape orientation.
4.	 The orientation of the page changes to Landscape. 

Setting Page Size

In Word 2016, different sizes 
of paper can be used to write a 
document.

Follow the given steps to change 
the page size of the Word.

Steps: 
1.	 Select Layout Tab.
2.	 In the Page Setup group, click on the size button.
3.	 A drop-down menu appears. The current page size is highlighted. 
4.	 Select the desired page size option.
5.	 The size of the page will change.

Figure 3.8: Page Orientation

Figure 3.9: Page Size
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  Working with Shapes
AutoShapes is a tool to help you draw 
objects on your document. There are 
many shapes such as lines, call-out, 
equation shapes and many more.

Follow the given steps to insert a shape 
in the document.

Steps:
1.	 Click on the Insert tab.
2.	 In the Illustration group, select the shapes button.
3.	 A drop-down menu will displayed.
4.	 Click on the desired shape.
5.	 The mouse pointer changes to (+) plus sign.
6.	 Take the plus sign to the desired place in the document and drag it to 

add the shape. 

Placing Text in a Shape

Text can also be inserted in the shape. 

Follow the given steps to add text in a shape.

Steps:

1.	 Select the shape you 
want to add text in.

2.	 Right-click on it.

3.	 A pop-menu appears, 
select the Add text 
option.

Figure 3.10: Shapes

Figure 3.11: Placing Text in a Shape
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4.	 Now type the text 
in the placeholder.

5.	 Click outside the 
placeholder to 
complete the task.

  Thesaurus

Microsoft Word 
includes a tool 
that enables 
you to perform 
synonym and 
antonyms 
searches using the Thesaurus. Also, we can also look up for a suggestion of 
a word. 
Follow the given steps to use the Thesaurus.
Steps:
1.	 Select the word for which you want a 

synonym or antonym.
2.	 Click on the Review tab.
3.	 In the proofing group, select the Thesaurus 

option.
4.	 The Research task pane appears with 

synonyms and antonyms.
5.	 Choose the desired word and select the 

Insert option.
6.	 The existing word will be changed with 

the new word.

Figure 3.12: Typing Text in a Shape

Figure 3.13: Thesaurus

Figure 3.14: Search for 
Synonyms or Antonyms
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  Drop Cap Effect

A drop cap (dropped capital) is a large capital letter used as a decorative 
element at the beginning of a paragraph or section. The size of a drop cap is 
usually two or more lines. 
There are two types of Drop Cap:
Dropped option allows you to create a drop cap that fits within your paragraph. 
The Margin option allows to create a drop cap that is in the margin, outside 
of your paragraph.

Follow the given steps to apply Drop Cap Effect.

Steps:
1.	 Select the first letter of a paragraph.
2.	 Click on the Insert Tab.
3.	 Select Drop Cap button and a drop-down menu appears.
4.	 Select either dropped or in margins as per your requirement.
5.	 The selected character will be changed.

  Header and Footer

Information is added to the top and bottom of each page using the header 
and footer, respectively.		

Figure 3.15: Drop Cap Effect
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Follow the given steps to add a header to your document.

Steps:
1.	 Click on the Insert tab.
2.	 In the Header 

and Footer 
group, select 
the header 
button.

3.	 A drop-down 
menu appears, 
select the 
Blank option.

4.	 A placeholder 
of the header will be displayed at the top margin of the document.

5.	 Click on the placeholder to add text.
6.	 In the close group, click on the close header and footer button. 
7.	 Observe the top margin of the document.

Follow the given steps to add a footer to your document.

Steps:
1.	 Click on the Insert tab.
2.	 In the Header 

and Footer 
group, select 
the footer 
button.

3.	 A drop-down 
menu appears, 
select the 
Blank option.

Figure 3.16: Adding Header

Figure 3.17: Adding Footer
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4.	 A placeholder of the footer will be displayed at the top margin of the 
document.

5.	 Click on the placeholder to add text.
6.	 In the close group, click on the close header and footer button. 
7.	 Observe the bottom margin of the document. 

  Removing Header or Footer

�� From the header drop-down menu, select remove header to withdraw 
header.

�� From the footer drop-down menu, select remove footer to withdraw 
footer.

Kids’ IQ
Harman is writing an article for her school magazine. She wants to use advanced 
vocabulary. Suggest the right option to her.

Let’s Recall
•	 Microsoft Word 2016 is the most popular word processor developed by Microsoft 

Corporation.
•	 Styling is the process of altering the font’s appearance in terms of size, color, and 

themes.
•	 The subscript option places the selected text slightly below the baselines.
•	 A margin is the amount of space between the text and the edge of the page. 
•	 AutoShapes is a tool to help you draw objects on your document.
•	 Information is added to the top and bottom of each page using the header and 

footer, respectively.
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Upskill Your Intelligence

A.	 Fill in the blanks
	 1.	 Microsoft word is the word processor developed by .....................
	 2.	 The smallest element in a word document is a ..................... 
	 3.	 Linked content is a mix of .................... and .....................
	 4.	 A list contains .................... and .................... list items.
	 5.	 The Subscript option places the selected text slightly .............................. the 

baseline.

B.	 Answer in one word.
	 1.	 The process of altering the appearance of font in terms of size, color and 

themes.
		  .............................................................................................................................
	 2.	 The option that places the selected text slightly above the baseline.
		  .............................................................................................................................
	 3.	 These are the special characters.
		  .............................................................................................................................
	 4.	 The command that allows you to discard the most recent change.
		  .............................................................................................................................
	 5.	 By default, Undo and Redo commands appear in this toolbar. 
		  .............................................................................................................................

C.	 Write ‘T’ for True statements and ‘F’ for False statements.
	 1.	 The outlook of a paragraph cannot be changed.	
	 2.	 The Redo command reverses the most recent change made using  

Undo.	
	 3.	 Press Ctrl + U to apply Undo Command.	
	 4.	 A margin is the amount of space between the text and the edge  

of the page.	
	 5.	 The default page orientation is landscape, which is horizontal.	

D.	 Tick the correct answer.
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	 1.	 In the word, .................... helps us look up for a suggestion of a word.
		    a. Header		    b. Footer
		    c. Thesaurus		    d. Drop Cap effect

	 2.	 A tool that helps you draw objects on your document.
		    a. Font	   b. Shapes	   c. Symbols	   d. Margins

	 3.	 Page size can be changed by clicking on .................... tab.
		    a. File	   b. Insert	   c. Design	   d. Layout

	 4.	 Dropped and In Margins are two options of .....................
		    a. Margins		    b. Drop Cap Effect
		    c. Paragraph		   d. Insert

	 5.	 The information which is added to the bottom of each page.
		    a. Header	   b. Footer	   c. Symbols	   d. Shapes

E.	 Answer the following questions.

	 1.	 Write the steps to apply styles to a Paragraph.
		  .....................................................................................................................................
		  .....................................................................................................................................
	 2.	 State the difference between Header and Footer.
		  .....................................................................................................................................
		  .....................................................................................................................................
	 3.	 What is the use of the Drop Cap effect in the word?
		  .....................................................................................................................................
		  .....................................................................................................................................
	 4.	 What do you mean by Subscript?
		  .....................................................................................................................................
		  .....................................................................................................................................
	 5.	 How can we set the Page Margins?
		  .....................................................................................................................................
		  .....................................................................................................................................
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Critical Thinking

A.	 Find the group names in the grid where the following options can be found.
	 1.	 Page Margins -	 ...............................................
	 2.	 Symbols - 		  ...............................................
	 3.	 Thesaurus - 		  ...............................................
	 4.	 Shapes -			  ...............................................

D Q J W E D R T Y U P I P
X A S P D F G P H I U J R
A S P F G J H I J H T K O
Y Q W E R T D W E R E T I
S D F G H J K J L I S H S
A Z X C V B N M H I E J L
A S D P R O O F I N G G O
P Z D X C C H V B N A N B
A P S D F G P H J K P L M
A P D J Q W E R T Y F E Y
I L L U S T R A T I O N S

B.	 A book publishing house wants to write the name of their company at the 
bottom of every page. Suggest to them the way to do it.

	 ....................................................................................................................................
	 ............................................................................................................................................

Team Work

A.	 Collect the information on Photosynthesis and make a project on MS-Word.

B.	 Write the equation of Photosynthesis using subscripts. 
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Mail Merge
4 

At the end of this chapter, students will be able to:
)) Know the features of Mail Merge.
)) Merge the components of the Mail Merge.
)) View and print the Merged Data.

Learning Outcomes

Warm-up
Shubham has recently adopted a puppy. He wants to throw a party for its 
homecoming. To invite his friends, he has written a letter in MS Word 2016. 
Now, he wants to send the same letter to his 15 friends. Discuss the ways he can 
do the same without taking much time.

Teacher’s 
Note:

With the help of the above activity, introduce the students to the mail merge feature of 
Word 2016.
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Your school sends the same circulars to all the students from classes 1-12 
on the daily basis. Do you think they type the e-mails of the students one by 
one? No. They use MS Word’s famous feature Mail Merge. 
Mail Merge feature of Word 2016 is used to combine data source, which 
contains all the addresses with the main document. This definitely saves a 
lot of time. 
Let’s learn about this feature in detail.

 Mail Merge

Mail Merge is a very efficient tool of MS Word. It is possible to write and 
send a letter or email to multiple recipients at once using the Mail Merge 
feature in Microsoft Word. From this tool, 
we can create form letters, mailing labels and 
envelopes by combining main documents 
with a data source.

Let’s learn about two very important components of Mail Merge:

�� Main Document: It contains the text which we want to send to all the 
recipients. 

�� Data Source: It consists of personalised information such as name, 
address, city, and phone. 

	 Numbers. This information is organised in tabular form with the field 
names.

“Hello friends! Let’s learn about the 
Mail Merge features 2016. It saves 
our time and efforts to send letters at 
multiple addresses.

Let Me Answer
Have you ever received a circular 
from your school on your e-mail id?
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Creating the Main Document

Follow the given steps to create the main document.

Steps:
1.	 Create a new document 

and type a letter, that you 
want to send to multiple 
addresses.

2.	 Click on the Mailings 
tab.

3.	 Click on Start Mail 
Merge drop-down arrow 
and select the Step-by-Step Mail Merge Wizard Option. 

4.	 The Mail Merge pane appears on the right side of the window.

Follow the given steps to create the document.
Steps:

1.	 Under the ‘Select document type’ section, select 
the letters radio button.

2.	 Click the Next: Starting document under the 
‘Step 1 of 6’ section at the bottom of the task 
pane. 

3.	 Under the Select starting document section, 
click on the Use the current document option.

Figure 4.1: Start Mail Merge

Figure 4.2: 
Selecting Document

Figure 4.3: Selecting recipients
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4.	 Under the ‘Step 2 of 6’ section, click the 
Next: Select recipients.

There are three ways to create the Recipients 
list:
1.	 Use Existing List: Select a list if you already 

have one, then click “OK.”
2.	 Select from Outlook contacts: Select a list 

from the address book of Outlook.
3.	 Type New List: If you don’t have a list, choose 

this option to build a list to be combined 
with your word document.

  Creating the Data Source

If there is no list, then we need to create a new list.

Follow the given steps to create a New List.

Steps:
1.	 Click on the create button.
2.	 The New Address List appears.

Figure 4.4: Type New List

Figure 4.5: New Address List
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Follow the given steps to enter records.

Steps:
1.	 To add values to the list, click on the New Entry button.
2.	 Fill in the information in the New Address List.
3.	 If you want to enter more records, click on the New Entry button.
4.	 Click on the OK button.
5.	 Give an appropriate name and click on the Save button.

Figure 4.6: New Address List

Figure 4.7: Save Address List
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  Merging the components of Mail Merge

After creating the data source, merge both the components: Main Document 
and Data Source together.

Follow the given steps to merge these two.

Steps:

1.	 Select the records you want to merge and click OK.

2.	 On the Mailings tab, click on the Insert Merge Field button to insert the 
fields from the database. 

Figure 4.8: Mail Merge Recipients

Figure 4.9: Insert Merge Field Button

Let Me Answer
What do you mean by merging?
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3.	 Select the field you intend to add and the 
field name will appear in the document.

  Viewing the Merged Data

Follow the given steps to preview the merged data.

Steps:
1.	 On the Mailings tab, click on the Preview Results button. Alternatively, 

click the Next: Preview your letters under the ‘Step 4 of 6’ section.

2.	 The data stored in the fields will appear.
3.	 Once you’ve previewed the records, click on the Finish Merge button.

Figure 4.10: Insert Merge Field

Figure 4.11: Preview Results

Do You Know?
To insert a merge field, we can press 
Alt + Shift + F Key combinations.
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  Printing The Merged Document

If you wish to directly print the letters then from the File tab, select the Print 
Option. 

Figure 4.12: Complete the Merge

Figure 4.13: Printing Merged Document
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If you intend to save the individual letters permanently and edit them later, 
click on the Edit Individual letters option.

To print the merged document, Alt + Shift + M Key combinations can be used.
Remember it!

Kids’ IQ
Roshni wants to insert a merge field but she has forgotten the steps which her teacher 
told to follow. Help her with a simple way for it. 

.....................................................................................................................................................

Let’s Recall
•	 Mail Merge is a very efficient tool of MS Word which allows you to write and send 

a letter or email to multiple recipients.

•	 Mail Merge consists of the main document and a data source.

•	 Main Document contains the text which we want to send to all the recipients. 

•	 Data Source consists of personalised information such as name, address, city, and 
phone. 

•	 Mail Merge saves time and typing efforts.

•	 Procedure you need to follow while using the feature of mail merging.

	 - Creating the main document.

	 - Creation of the data source.

	 - Merging the components of mail merge.

	 - Viewing the merged data.

	 - Painting the merged document.
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Upskill Your Intelligence
A.	 Fill in the blanks.
	 1.	 ......................... feature of word 2016 is used to combine a data source with the 

main document.
	 2.	 Two important components of Mail merge are .................... and ......................
	 3.	 ......................... consists of personalised information.
	 4.	 ......................... tab needs to be clicked in order to create the main document. 
	 5.	 The Mail Merge Pane appears on the ......................... side of the window.
B.	 Answer in one word.
	 1.	 The tab which you select to execute the mail merge option.
		  .............................................................................................................................
	 2.	 Component of Mail Merge which contains the text we want to send to all 

recipients.
		  .............................................................................................................................
	 3.	 The option we choose to select a list from the address book of Outlook.
		  .............................................................................................................................
	 4.	 The button which is clicked to insert the fields from the database.
		  .............................................................................................................................
	 5.	 The options to see the records before merging.
		  .............................................................................................................................
C.	 Write ‘T’ for True statements and ‘F’ for False statements.
	 1.	 The two main components of a mail merge process are the main  

document and data source.	
	 2.	 Edit Individual letters option allows you to save the individual letter 

permanently and edit it later.	
	 3.	 To add values to the list, we click on the New Entry button. 	
	 4.	 Information in Data Source is organised in tabular form with the field names.	

	 5.	 You can select the list from the address book of outlook.	
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D.	 Identify and label the following buttons.

	 .............................................................		      .............................................................

	 .............................................................		      .............................................................

E.	 Answer the following questions.

	 1.	 What do you mean by Mail merge?

		  .....................................................................................................................................

		  .....................................................................................................................................

	 2.	 How can we create a Main document?:

		  .....................................................................................................................................

		  .....................................................................................................................................

	 3.	 What is a Data source?

		  .....................................................................................................................................

		  .....................................................................................................................................
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	 4.	 How can we merge the Main document and Data source together?

		  .....................................................................................................................................

		  .....................................................................................................................................

	 5.	 Write the different ways to select a Recipient list.

		  .....................................................................................................................................

		  .....................................................................................................................................

Critical Thinking

A.	 Here are the steps to preview the merged data. Number them in sequence.

	 1.	 The data stored in the fields will appear.	

	 2.	 Once you’ve previewed the records, click on the Finish Merge button.	

	 3.	 On the Mailings tab, click on the Preview Results button.	

B.	 It’s Samaira’s birthday. She has made a beautiful invite using MS Word. She 
wants to send a personal invitation to her friends without typing their names 
and address again and again. Suggest to her the way she can do this task.

	 ....................................................................................................................................
	 ............................................................................................................................................

Team Work

A.	 You are the head of your class. Create a data source of your classmates which 
includes their personal information such as Name, date of birth, address, 
phone numbers, and parent’s names for the School identity :

	 1.	 How many students are there in your class?
	 2.	 How many prints of students information are more?
	 3.	 How did you paste the logo of your school in the identity card?
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Upgrading Presentation
5 

At the end of this chapter, the students will be able to:
)) Insert the objects in the placeholder.
)) Add WordArt, SmartArt and shapes in a presentation.
)) Do animations and transitions in a presentation.

Learning Outcomes

Warm-up

Naman and Akhil have been told to complete the task. They have managed to do 
so but are unable to tell the name of the software application. Now, it’s your turn 
to join the dots to find the following software application.

Teacher’s 
Note:

Ask students to name the above software application. Also, tell them to recall MS 
PowerPoint application features which they learned in their previous class.
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As we already know, Microsoft PowerPoint is a software application that 
allows you to create and show slides to support a presentation. In this chapter, 
we will learn how to use the right effects on text 
and objects to make our presentations more 
visually appealing and meaningful.

 Adding Objects in a Presentation

Placeholder

A placeholder is a region 
surrounded by dotted 
borders on a slide. The first 
slide of a new presentation 
has two placeholders on it 
by default.

Different types of 
content, text and images 
can be added in a 
placeholder.

“Hello friends! Let us make our presentations 
more engaging and powerful by adding WordArt, 
SmartArt, shapes, Animations and transitions in 
our presentation.

More than 500 Million people 
use PowerPoint worldwide.

Remember it!

Figure 5.1: Different Placeholders

Figure 5.2: Placeholders

Placeholders

Click an icon to 
insert other content

Click and begin 
typing to add text

Placeholders
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Follow the given steps to add text to a placeholder.

Steps:
1.	 Move the cursor to the ‘Click to add title’ placeholder and click it.
2.	 Type the Title of the presentation in the placeholder.
3.	 Likewise, move the cursor to the ‘Click to add subtitle’ placeholder and 

click it. Then, type the Subtitle of the presentation in the placeholder.

Editing Text with WordArt

WordArt is a feature that creates text effects which are not available through 
font formatting. Adding WordArt to the slides makes them attractive.

Figure 5.3: Adding Text in the Placeholder

Figure 5.4: Inserting WordArt

Let Me Answer
What do you mean by WordArt?
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Follow the given steps to insert WordArt.

Steps:
1.	 Select the text in the placeholder.
2.	 Click the Format tab. Click the drop-down arrow next to the WordArt 

styles.
3.	 A list of WordArt styles will appear, click on the desired style.

4.	 Observe the change in the text.

Follow the given steps to apply the text effects.

Steps:
1.	 Select the text in the placeholder.

Figure 5.5: WordArt Styles Group Figure 5.6: WordArt Styles Preview

Figure 5.7: Applying Text Effects
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2.	 Click the Format tab. In the WordArt Styles group, click the Text effects.
3.	 From the drop-down list box, select the desired text. 
4.	 Observe the change in the text.

Inserting Shapes

In MS PowerPoint, a range of shapes are available that can be added to the 
presentation. Adding shapes to the slides enhance the appearance of the 
presentation.
Follow the given steps to insert shapes to a slide.

Steps:
1.	 Click on the Insert tab.
2.	 In the illustrations group, select the shapes button.
3.	 From the drop-down menu, select the shape you 

want to add.
4.	 To draw the desired shape, click and drag the 

mouse on the slide.
5.	 Release the mouse button.
6.	 The chosen shape will appear on the slide.

Follow the given steps to rotate and resize a shape.

Steps:

1.	 Click the shape you want to modify.

2.	 Sizing handles will appear on the corners, drag one 
of them to get the desired size.

3.	 Similarly, move the rotating handle on the top to 
rotate the desired shape.

Adding Text to a Shape

In PowerPoint, text can also be added to any shape.

Figure 5.8: Inserting Shapes

Let Me Answer
What shapes are available in MS 
PowerPoint?
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Follow the given steps to add text in a shape.

Steps:
1.	 Select the shape in which you want to add the text.
2.	 Right-click on it, and a pop-up menu will appear.
3.	 Click on the Edit Text option and add text to the shape.

Inserting SmartArt

One of the features of PowerPoint is SmartArt. A SmartArt graphic is a visual 
representation of information and ideas as well as numeric values or data. 

Follow the given steps to insert SmartArt.

Steps:
1.	 Go to the slide where you 

want the SmartArt graphic 
to appear.

2.	 Click on the Insert Tab.
3.	 In the illustrations group, select the SmartArt Button.
4.	 A dialogue box ‘Choose a SmartArt Graphic’ will appear. 
5.	 Select the category and type from the list.

Figure 5.9: Insert Tab

Figure 5.10: Applying SmartArt
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6.	 Double click on the desired 
SmartArt to insert a graphic in 
the slide.

7.	 The SmartArt graphic will 
appear along with a text 
placeholder.

8.	 Insert the text as you wish to.

  Animations and Transitions

When you watch an animated film, the scenes keep coming one after the 
other. Have you ever wondered why? This is because of the transitions. The 
same effect can be done in a PowerPoint presentation also by slide transition.

Slide Transition

Transitions are animation effects which 
can be applied to slides. The way one slide follows the other on the screen 
in a presentation is called transition. When a slide enters or exits during the 
slide show, we may adjust the speed of each transition and even add sound.

Let us explore the transition styles found on the Transitions tab. 

Subtle Transitions

Exciting Transitions

Figure 5.11: Inserting SmartArt

Figure 5.12: Subtle

Figure 5.13: Exciting

Do You Know?
Email Cohl is referred to as the Father of 
the animated cartoon.
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Dynamic Content

Follow the given steps to apply slide transition. 

Steps:
1.	 Select the desired slide from the Slide Navigation pane on which you 

want to apply the transition.
2.	 Click on the Transitions tab.
3.	 Click on the drop-down button to see all transitions.
4.	 Choose the transition effect of your choice.

5.	 A preview of the transition effect appears in the slide area.
6.	 Click on Apply to all option from the Timings group.

Applying Animation to Text and Objects

Transitions and slide animations are similar, however, slide animations apply 
to specific elements on a single slide- a title, chart, image, or individual bullet 
point. Animation makes a presentation look attractive and eye-catchy. 

Let us explore the four types of animations available.

Figure 5.14: Dynamic Content

Figure 5.15: Applying Transition
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Figure 5.16: Entrance Effects

Entrance: These animations manage how an object enters a slide.

Emphasis: Specific contents are highlighted using these animations.

Exit: These animations manage how the object leaves the screen.

Motion Paths: When an object follows the designated path, these animations 
are used to add animation.

Follow the given steps to apply an animation to an object.
Steps:
1.	 Select the desired object.
2.	 Click the Animations tab, and click on the More drop-down arrow to 

view the available animations.

Figure 5.17: Emphasis

Figure 5.18: Exit

Figure 5.19: Motion Paths

Figure 5.20: Animation Tab
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3.	 Select the animation effect from Entrance, Exit or Emphasis option.

4.	 Click the preview button to preview the applied animation effect.

Kids’ IQ
Saman has 50 photographs in a folder which she wants to add in all the slides . Further, 
she wants to add animation effects to these slides. Suggest her the option to complete 
this task.

Let’s Recall
•	 A placeholder is a region surrounded by dotted borders on a slide.
•	 Adding shapes to the slides enhance the appearance of the presentation.
•	 In PowerPoint, text can also be added to any shape.
•	 A SmartArt graphic is a visual representation of information and ideas as well as 

numeric values or data.
•	 Transitions are animation effects which can be applied to slides.

Figure 5.21: Animation Preview
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Upskill Your Intelligence

A.	 Fill in the blanks.
	 1.	 PowerPoint is a software application that allows you to create and show slides 

to support a ..........................
	 2.	 A ......................... is a region surrounded by dotted borders.
	 3.	 ......................... is a visual representation of information and ideas.
	 4.	 ......................... animation manage how the object leaves the screen.
	 5.	 ......................... is a feature that creates text effects which are not available 

through font formatting.

B.	 Identify the following options in MS PowerPoint.

C.	 Answer in one word.
	 1.	 How many placeholders are there on the first slide of a new presentation?
		  .............................................................................................................................
	 2.	 In which tab are Word Art styles present?
		  .............................................................................................................................
	 3.	 The way one slide follows the other on the screen in a presentation.
		  .............................................................................................................................
	 4.	 This animation manages how an object enters a slide.
		  .............................................................................................................................
	 5.	 In which group does a SmartArt button present?
		  .............................................................................................................................

D.	 Write ‘T’ for True statements and ‘F’ for False statements.
	 1.	 Text can be added to shapes.	
	 2.	 Transitions and slide animation are similar.	
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	 3.	 Entrance animations manage how the object leaves the screen.	
	 4.	 We can adjust the speed of each transition. 	
	 5.	 Multiple animation effects can be applied to an object.	
E.	 Answer the following questions.
	 1.	 What do you mean by Slide transition?
		  .....................................................................................................................................
	 2.	 Write the steps to insert SmartArt.
		  .....................................................................................................................................
	 3.	 How can we apply animations to text and objects?
		  .....................................................................................................................................
	 4.	 Can we rotate a shape? If yes, then how?
		  .....................................................................................................................................

Critical Thinking

A.	 Naman has to make the food web diagram. For it, he wants to show the 
relationship between different animals. He wants to display the same using 
cycle form. Suggest to her the ways to achieve the task.

B.	 Unscramble the letters to form a correct word.

	 1.	 EELPACHDOLR - 	.........................................................

	 2.	 DILSE -			  .........................................................

	 3.	 EEPSRTTANIO-	 .........................................................

	 4.	 XTTE-			   .........................................................

	 5.	 SSPHEA-		  .........................................................

Team Work

	 Find out the information on ‘Covid-19’ and make a presentation utilising all 
the features learnt in Microsoft PowerPoint.
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Programming In Scratch
6 

At the end of this chapter, the students will be able to:
)) Sense input and its execution.
)) Use Mathematical Operations in Scratch.
)) Add the various blocks of the Control block.

Learning Outcomes

Warm-up
Rahul wants to change the costume of the Sprite. Steps are given below but are 
not in order. Arrange them in order to help Rahul.
Follow the given steps to change the costume of a Sprite.

Steps:
1.	 From the list of costumes, select 

Dani-b costume.
2.	 Click on Choose a Sprite button on 

the bottom right side of the Scratch 
window.

3.	 The sprite’s costume will be 
changed.	

4.	 Select Dani Sprite to click on the 
Costume tab.

Teacher’s 
Note: Assist the students in arranging the above steps in a chronological order.
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The various tasks that a sprite can carry out on the Scratch stage are already 
known to us. We have also learnt how to change the background, colour, 
direction, and costume of a Sprite. Let us now learn how to perform various 
sensing and mathematical operations to solve a problem.

Do You Know?
Scratch service developed by the MIT Media Lab, has been translated into 70+ languages, and is used 
in most parts of the world.

  Sensing Input and Its Execution

The light blue color-coded Sensing blocks are among the eight categories of 
Scratch blocks. They are used to sense the keyboard input while executing 
the script as well as the location of the mouse pointer and its distance from a 
Sprite. Further, these blocks determine whether a Sprite is touching another 
sprite. Hence, these blocks give your Sprites the ability to sense an action 
that takes place.

Sensing a Mouse Click

When we click the right mouse button down, the sensing block responds. 
This implies that we can create a Sprite or part of our programme in such a 
way that it would react to our activities.

This is another example of event-driven programming. When the mouse 
button is clicked, the script runs.

“Hello friends! Let’s learn 
about a few more blocks of 
code in Scratch.

Let Me Answer
What do you mean by sensing?
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Sensing a Key

When a user touches a certain key on the keyboard key space is pressed, this 
block can be used to detect it.

When Two Sprites Collide

This is used to detect a sprite and respond to 
contact with another Sprite on the stage. This 
is done by telling the Sprite to do something 
when one color touches another color. 

Look at the code, it tells the Sprite to change to 
the next costume when the color red touches 
the color yellow.

Asking a Question

This block stores keyboard input in the answer 
block while enabling us to put a question on 
the screen. The question is displayed in a call-
out on the screen. While the user enters an 
answer or presses the enter key, the application 
waits.

  Using Operators

Operator blocks are light green-colored coded blocks and 
are round in shape. They are used to solve mathematical 
equations. Basic mathematical operations, logical operations, 
and different functions are all included in the operators group 
blocks.
Let us perform calculations in a Scratch Project.
Steps:
1.	 Open a new file in the Scratch window. 

Figure 6.1: Responding to Contact

Figure 6.2: Asking a Question

Figure 6.3: 
Operators

Let Me Answer
What do you mean by the term collide?
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2.	 Delete the cat sprite, and choose sprite from the library button.
3.	 Select the Crab sprite from the Animals category and click ok.
4.	 Drag the when flag clicked (crop from button file) block from the Events 

block category and place it in the script area.
5.	 Take the say hello for 2 seconds(crop from button file) and say hello(crop 

from button file) blocks from the Looks block category and place them 
under the when flag clicked(crop from button file) in the script area.

6.	 Drag the - (crop from button file) block from the Operators block 
category and club it inside the say hello block. 

7.	 Type the text and numbers inside the block as shown in the figure.
8.	 Click the blocks to run the script.
9.	 Observe the Sprite displaying the calculations.

  Working With Variables

You may have noticed that when you progress to the next level in playing 
computer games, your score either rises or falls and is displayed on the screen 
at the end. These values are stored by using variables. A Variable is a name 
given to a place in the memory of the computer. These values can be either 
numbers or text.

With the Scratch app, users can snap together computer programming blocks to make 
interactive stories, games, art, animations, and more.

Remember it!

Figure 6.3: Sprite subtracting two numbers on the Stage
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Creating a Variable

Follow the given steps to create a variable.

Steps:
1.	 In the block palette, click the variable category.
2.	 Select the Make a Variable button.
3.	 Name the variable.
4.	 Use the options available.

  Conditional Statement

Sometimes, we want to have programs that respond differently in different 
situations. We might want the program to say ‘It’s your turn’, ‘You win’ or ‘you lose’. 

Figure 6.4: Creating Variables

1.

4.

3.

2.
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In Scratch, ‘ wait 1 second’, ‘repeat 10’, ‘if ’, ‘forever if ’ or ‘if then’ are the 
conditional blocks present in the Control blocks category. 

‘Wait 1 second’ block halts the script’s execution for some duration as 
mentioned in the block. 

‘Repeat 10 block’ repeats a set of instructions a specified number of times. 

In if then block, the script inside it will execute, only if the condition given 
after if is true. If the condition is false, no code is executed. 

The ‘if else’ block checks the condition between if .. then, if it is true then 
block place after if..then will execute. If it is false, then the blocks placed after 
else will be executed. 

In ‘forever block’, a set of instructions keep repeating until the interrupting 
button - the stop button - is pressed.

Kids’ IQ
Sam has written a statement in Scratch and he wants to repeat the statement at least 10 
times. Suggest to him the block by which he can complete this task.

.....................................................................................................................................................

Let’s Recall
•	 The light blue colour-coded Sensing blocks are among the eight categories of 

Scratch blocks used to sense the keyboard.
•	 The category of Operators group blocks of basic arithmetic operations, logical 

operation and various functions.
•	 A variable is a name given to a place in the computer’s memory.
•	 The if else block checks the condition between if .. then, if it is true then block 

place after if..then will execute. If it is false, then the blocks placed after else will be 
executed. 

•	 In forever block, a set of instructions keep repeating until the interrupting button 
- the stop button - is pressed. 
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Upskill Your Intelligence

A.	 Fill in the blanks.

	 1.	 Sensing blocks are of ......................... color.

	 2.	 Operator blocks are ......................... in shape.

	 3.	 When we click the ......................... mouse button, the sensing block responds. 

	 4.	 The question is displayed in a ......................... on the screen.

	 5.	 ......................... blocks are used to solve mathematical equations.

B.	 Write ‘T’ for True statements and ‘F’ for False statements.

	 1.	 Sprites can react to our activities.	

	 2.	 A variable is a name given to a place in the memory of the computer.	

	 3.	 Stop all block stops the execution of a script.	

	 4.	 Forever block repeats a set of instructions a specified number of times.	

	 5.	 Say hello block is in Looks block category.	

C.	 Match the following.

	 1.	 Sensing blocks	 Light-green color

	 2.	 Operator blocks	 In Events blocks

	 3.	 When Flag clicked block	 Script execution stops for a specified time

	 4.	 Wait block	 Light-blue color

D.	 Answer the following questions.

	 1.	 Write the steps to create a variable.

		  .....................................................................................................................................

		  .....................................................................................................................................
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	 2.	 What do you mean by conditional statement?

		  .....................................................................................................................................

		  .....................................................................................................................................

	 3.	 What is the purpose of ‘Sensing a Key’?

		  .....................................................................................................................................

		  .....................................................................................................................................

	 4.	 Why do we use variables?

		  .....................................................................................................................................

		  .....................................................................................................................................

	 5.	 What are sensing blocks? Explain any two.

		  .....................................................................................................................................

		  .....................................................................................................................................

Critical Thinking

	 Harmeet has created  a program in Scratch and she wants her Sprite to repeat 
a set of instructions forever. Recommend her the block to accomplish the task.

Team Work

	 Learn how to use different blocks that are accessible in Scratch and their diverse 
functions.

	 1.	 What did you learn after the discussion? 

	 2.	 Conclude your points as a project on a word file.
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Introducing MS Excel 20167 

At the end of this chapter, the students will be able to:
)) Know the features of Excel.
)) Enter data and Perform calculations in a Worksheet.
)) Learn types of data.
)) Save a workbook.

Learning Outcomes

Warm-up
Ram has got the Marks card for his first term examinations. He has to calculate 
his total marks. Help him to do the task.

Subjects Theory Practical Obtained Total

English 79 18 100

Hindi 75 19 100

Maths 79 20 100

Science 72 17 100

Social Studies 65 15 100

Computer 77 18 100

Total

Teacher’s 
Note:

Apprise the students that in the above activity, text and numbers have been organised 
in rows and columns which can be defined as a Spreadsheet. Also, inform them this task 
would have been very easily done in Microsoft Excel by applying simple formulas.
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“Hello friends! Let’s learn 
about the MS Excel and 
its various type of data 
features. Let’s learn to 
enter data into it.

Microsoft Excel is a popular spreadsheet. A spreadsheet can be defined as 
text and numbers that have been organised in rows and columns. It is widely 
used to perform mathematical calculations. It 
also provides features such as formulas, functions 
and data analysis tools that make it easier to deal 
with a large amount of data.

Do You Know?
Excel was the first software that 
introduced a toolbar

Figure 7.1: Microsoft Excel
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  Features of MS EXCEL 2016
�� Excel has built-in formulas and functions to do calculations.
�� Easy data entry and sorting of data.
�� Searching and replacing data can be quick.
�� When we make a change at one place in a worksheet, the entire spreadsheet 

is automatically recalculated.
�� Data can be represented in charts and graphs for comparing the data 

effectively.
�� By using the Auto Fill option, quick data entry can be done in a large 

series of cells.

Let us learn how to Start MS Excel 2016.

Starting Excel 2016

Follow the given steps to start MS Excel 2016.

Steps:

1.	 Click on the Start button.

2.	 Scroll down to find Excel 2016.

3.	 Click on it.

4.	 The Excel 2016 window appears.

Figure 7.2: Starting Excel Figure 7.3: Excel Window
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  Components of MS Excel 2016 Window

Cell

A cell is an intersection of rows and columns. It is the smallest unit in a 
worksheet and text, as well as numbers, can 
be written in it. Each cell has its unique cell 
address identified by its column letter and 
row number.

Worksheet
A worksheet in Excel is a collection 
of cells organised into rows and 
columns. A single worksheet 
has 1,048,576 rows and 16,384 
columns.

Workbook
An excel is called a workbook.  
By default, the file name of 
a new workbook is Book 1. 
There are many worksheets in a 
single workbook. We can edit, 
delete, hide and rename these 
worksheets.

Figure 7.4: Cell

Figure 7.5: Worksheet

Figure 7.6: Workbook

Let Me Answer
State the difference between a remote’s 
cell and a cell in Ms Excel.

Cell Address

Cell
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Components of a Worksheet

	 1.	 Title Bar: Located at the top of the Excel window, it displays the name 
of the currently opened Workbook. 

	 2.	 Address Bar: It shows the address of the active cell.
	 3.	 Sheet Tab: It is present at the bottom left side of the Excel window. It 

shows the number of worksheets in a workbook and the active sheet. 
By default, the names of the worksheets are sheet 1, sheet 2 and so on. 

	 4.	 Active Cell: The cell which is currently selected and surrounded by a 
thick black border. The data can be typed into an active cell only. 

	 5.	 Horizontal Scroll Bar and Vertical Scroll Bar: They are used to scroll 
the worksheets up and down or left and right to view the entire sheet.

	 6.	 Formula Bar: The contents of the active cell are shown here. Data or 
formulas can be typed or edited in the formula bar.

	 7.	 Status Bar: It is present at the bottom of the Excel window. It displays 
the name of the selected command or status information. 

Row Heading

Cell Address

Address Bar Title Bar

Active Cell

Status BarSheet Tab

Formula Bar
Column Heading

2

10

1

4

71

9

6
8

Scroll Bar
5

Figure 7.7: Excel Worksheet Layout
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	 8.	 Columns Heading: Vertical section of the table which is numbered 
with alphabetic values such as A, B, C AND SO ON. Each column has 
its identification with its column number such as A1, A2,..and so on.

	 9.	 Rows Heading: Horizontal section of the table which is numbered with 
numeric values such as 1,2,3… and so on.

	10.	  Cell Address: Cell Address shows the column letter and row number 
of each cell. For example, D3 is the cell address referring to the cell with 
column B and row 2.

Microsoft considered many other names before finally landing on Excel. Other serious 
considerations were “Mr. Spreadsheet” and “Master Plan”.

Remember it!

  Creating a New Worksheet

Follow the given steps to create a New Worksheet.

Steps:
1.	 Click on the File tab. A 

backstage view appears.
2.	 Click on New, and a blank 

workbook will be displayed 
with Sheet 1 as Default 
Worksheet.

  Data Entry

Follow the given steps to enter the data in MS Excel.

Steps:
1.	 Click on the cell.
2.	 Type the text or numbers.
3.	 Press the Enter key.

Figure 7.8: Workbook
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  Types of Data

Three types of data can be entered in a Microsoft Excel Worksheet.
1.	 Numbers: Values that have numerals from 0 to 9 and the characters like +,-

,and many more. These can be used in calculations. By default, numbers are 
right aligned in a cell.

2.	 Text: Text can contain data like alphabets, numbers, spaces and special characters. 
It is not used in calculations. By default, the text is right aligned in a cell.          

3.	 Formulae: It is a mathematical equation which calculates the value of the cell. 
They can range from basic calculations to complex calculations.Remember: 
Formulae begin with an equal to (=) sign

Doing Calculations in a Worksheet
The most efficient feature of MS Excel is to perform calculations by creating 
formulae. Formulas perform mathematical calculations on the data values 
stored in a worksheet. The result of the calculation is displayed in the cell 
where the formula is entered.

Operation Symbol Operator
Addition + Plus

Subtraction - Minus
Multiply * Asterisk
Divide / Forward Slash

We can use simple or complex 
mathematical formulas or 
formulae in Excel.

In the example given below, 
formulae will be applied to do 
the addition of values. Formula 
= (C3+D3+E3) and press enter. 
Formula is entered is cell F3. Figure 7.9: Excel Formula
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  Saving a Workbook

Follow the given steps to save a workbook.

Steps:
1.	 Click on the File tab.
2.	 Select the option Save or Save As.

  Opening a Workbook

Follow the given steps to open a saved workbook.

Steps:

1.	 Click the File tab.

2.	 Click the Open option, and the open dialogue appears.

Figure 7.9: Browse Option Figure 7.10: Save As Dialog Box

Figure 7.11: Open Option Figure 7.12: Open Dialog Box
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3.	 Browse and navigate to the folder to open the saved workbook. 
4.	 Select the file and click on the Open button.

  Closing a Window

Follow the given steps to close the Workbook.

Steps:
1.	 Click the File tab.
2.	 Click on the close option. 
3.	 The current workbook 

will close.
The above steps will close the 
workbook, but to close the 
Excel window click on exit or 
press Alt + F4.

Kids’ IQ
Raman has to enter the formula for calculating the marks. He doesn’t remember the 
sign he needs to add before writing the formula. Suggest him the sign by which he can 
complete the task.

Let’s Recall
•	 A cell is an intersection of rows and columns.
•	 A worksheet in Excel is a collection of cells organised into rows and columns.
•	 An excel is called a workbook.
•	 By default, the text is right aligned in a cell.  
•	 The most efficient feature of MS Excel is to perform calculations by creating 

formulae

Figure 7.13: Closing a Workbook
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Upskill Your Intelligence

A.	 Fill in the blanks.
	 1.	 Microsoft Excel is a popular ..........................
	 2.	 Excel has built-in formulas and functions to do ..........................
	 3.	 A cell is an intersection of ......................... and ..........................
	 4.	 A single worksheet has ......................... rows and ......................... columns.

B.	 Write ‘T’ for True statements and ‘F’ for False statements.
	 1.	 Formulae is  a mathematical equation which calculates the value of  

the cell.	
	 2.	 Two types of data can be entered in a Microsoft Excel worksheet.	
	 3.	 There is a single worksheet in a workbook.	
	 4.	 The file in excel is saved with an extension .xlsx.	

C.	 Answer the following questions.

	 1.	 Write any three features of MS Excel 2016.

		  .....................................................................................................................................

	 2.	 Write the components of a worksheet. Explain any three.

		  .....................................................................................................................................

	 3.	 Explain the types of data entered in a Microsoft Excel worksheet.

		  .....................................................................................................................................

Critical Thinking

	 Shobhit has entered the name of the students from cell B1 TO B6. Now, he is 
unable to recognise the column heading. Help him in identifying the column 
heading in the cell range B1 to B6?

Team Work

	 Find out your stationery expenses on a daily basis and represent it in MS Excel 
for two months. Calculate the total expenses in a week and a month.
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Model Test Paper
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Model Test Paper


